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Organisation and Conditions for Assessment
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Organisation and Conditions for Assessment

The assessment is designed to test the candidate’s ability to apply knowledge and understanding and
practical skills, developed through study of the Relational Database Systems and Using Information
units. The mark out of 60 should be submitted to the SQA unscaled. This will be combined with the
examination mark out of 140 to establish the candidate’s overall grade of award. This mark should
also be used in conjunction with internal examination marks or other evidence in the preparation of a
candidate’s estimated grade of performance.

The notional design length for the assessment is 8-10 hours. However, a candidate may be permitted
additional time if required.

The assessment is to be undertaken under “open book™ conditions, but under the supervision of a
teacher or lecturer to ensure that the work submitted is the candidate’s own work. The teacher or
lecturer may give the candidate guidance and/or help if requested. Any such help should be reflected
in the marks awarded.

Once the task has been completed and marked, it should not be returned to the candidate for
further work.

These instructions are designed to be used in conjunction with data files provided with the electronic
distribution of the task. These can be downloaded from the SQA secure website.

Scottish Qualifications Authority 5
Coursework Task

Higher Information Systems 2012/2013



Special Arrangements for Higher Coursework 2012-2013

Centres are asked to pay special attention to the following arrangements.

Candidates are not required to spend time entering data into a database. Instead, the data should be
prepared beforehand and provided to candidates by the centre.

To facilitate this, Microsoft Access (2003 format) and Filemaker (v.7) as well as text (tab) delimited
and csv data files have been provided. It is intended that candidates will be provided with two
versions of the database.

The first database (SRCA Task 2) contains three of the tables of the system; Driver, Car and Club.
Each table will have all attributes correctly implemented although the tables will not be related.
Candidates will be require to create the Event table from the completed data dictionary and then set up
the relationships between all the tables. Candidates will be required to submit a printout of the
Documenter (or equivalent) of the Event table only as evidence for Task 2(a). Filemaker Pro users
should include a screen shot to show times formatted to two decimal places. Evidence for Task 2(b)
could be generated from the Documenter again (selecting only Relationships in the options) but the
evidence must show three correct one-to-many relationships. Candidates will not use their database
structures to complete Tasks 3-5. Instead, centres should issue candidates with the second, fully
populated database.

The second database (SRCA Tasks 3-5) will be a complete implementation of the system. This will
include all validations, relationships etc — ie an exact implementation of the data dictionary provided
to candidates at Task 2. This working database should be issued to candidates after Task 2 has been
submitted. Candidates must use this working database to complete Tasks 3-5.

Microsoft Access and Filemaker files are provided. Centres using other systems will require to create
both versions of the databases from the tab separated file and csv files provided. These files can also
be used if centres encounter any difficulties with the supplied Access or Filemaker databases.

Additional notes follow which detail how candidate evidence is to be generated.

Scottish Qualifications Authority 6
Coursework Task

Higher Information Systems 2012/2013



Notes:

Candidates may be reminded that this Coursework is taken under “open book” conditions. As
such, use may be made on on-line help facilities, notes or any other support materials in the course
of carrying out tasks.

Candidates should be given a copy of the marking grid from Section 3 (not the detailed marking
instructions) before starting the task so that they are aware of the mark distribution for each part.

The entire Coursework Task consists of nine tasks. Centres should take note of the points detailed
below for each task.

Task Evidence

1 Hardcopy of proforma provided or can be produced by the candidate. Task 1 must be
completed and data dictionary handed in for marking before the materials for
Task 2 are issued.

2 (a) Documenter (MS Access) printout or equivalent showing table structure for the Event
table only.

2 (b) Printout showing correct cardinality of relationships (Documenter in Access can be used

to produce only the relationships information through the options).

o] In FileMaker Pro8, to get a printout of the design, candidates should adhere to
the following instructions.

(1)  Select the “Define” option from the File menu and then select the
“Database” option from the sub-menu.
(2)  Click on the Tables tab.
(3) Highlight both tables by clicking on the name of the first table then
holding down the shift key and clicking on the other table.
(4) Click on the Print button.
o] In MS Access, to get a printout of the design, candidates should adhere to the
following instructions.
(1)  Select the “Analyze” option from the Tools menu and then select the
“Documenter” option from the sub-menu.
(2)  Select the table(s) required and then click Options button.
(3)  Make sure that the following options are checked/selected:
) Include for Table
> Properties
> Relationships
o Include for Fields
> Names, Data Types, Sizes and Properties
) Include for Indexes
> Names and Fields
(4) Required table design is displayed on screen and can be printed.
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ES Print Table Definition EJ
Include For Table

]

[[]Permissions by User and Group

Include For Eields
() Mothing
O Mames, Data Types, and Sizes

@NamesJ Data Types, Sizes, and Propetties

Include For Indexes

() Mathing
(%) Names and Fields

(O) Mames, Fields, and Properties

Task 2 (b) also requires a printout or hardcopy of the relationships.

o] Printing Relationships in FileMaker 8.

(1)  Select the “Define” option from the File menu and then select the
“Database” option from the sub-menu.
(2)  Click on the Relationships tab then click on the Print button.

o] Printing Relationships in Access

(1)  Open the Relationships window.
(2)  Select the “Print Relationships™ option from the File menu.

3 Printout of report.

4 Printout of report, proof of each club on single page with evidence to show that there are
5 pages in total.

5 Hardcopy that clearly shows use and details of macro or script (again, available through
Documenter in Access — simply change options in dialogue box).

6 Printouts of screenshot and HTML.
Mark webpage implementation from HTML.

7 Printouts of screenshot and HTML.
Mark webpage implementation from HTML.

8 Printouts of screenshot and HTML.
Mark webpage implementation from HTML.

9 Printout of document.

Screenshots for multiple tasks may be combined into a single page/document but should be
clearly labelled as to which task each screenshot is evidence for.
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Coursework Task: The Scottish Racing Car Association

Higher Information Systems Coursework Task 2012-2013

Background
The Scottish Racing Car Association (SRCA) organises a series of events throughout the year.

To participate in any event a Driver must be licensed and be a member of one recognised car Club.
A Driver may drive a different car at different events but can only drive one car at any particular
event.

A Car must be registered for racing and be suitable for one of the following classes — Street Standard,
Street Modified, Racing. Once a car is approved for racing it is given a unique 1D number.

Only one Event may take place on a particular date. At any event a driver may only drive one car but
a car may be driven by more than one driver. Drivers race one at a time against the clock along the
course. Each driver is allowed three attempts at the course and the time for each attempt (which is
always less than 100 seconds) is recorded. The course cannot be completed in less than 40 seconds by
any class and any attempt which is not started or not completed is awarded a time of 99.99 seconds.
The winner of each class is the driver with the lowest total time over all of their three attempts.

SRCA use a relational database to manage this information.

The relational data model is shown on the next page.
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Entities

The resulting data model is shown below where primary keys are shown in bold and underlined,
while asterisks (*) indicate foreign keys.

Driver (LicenceNo, DriverForename, DriverSurname, DriverAddress, DriverTown, DriverPostcode,

ClubName*)
Car (CarlD, Make, Model, Class)
Club (ClubName, SecretaryForename, SecretarySurname, SecretaryAddress, Secretary Town,

SecretaryPostcode, SecretaryTelephone)
Event (LicenceNo*, CarlD*, EventDate, Timel, Time2, Time3)

The entity-relationship diagram for the system is shown below.

Club Driver Event Car
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A data dictionary has been produced prior to implementation in a relational database. Part of this is
shown below.
Data Dictionary
Entity Attribute PK/ Data Unique | Required | Validation
FK Type/Size
Driver LicenceNo PK Number Y Y
DriverForename Text (30) N Y
DriverSurname Text (30) N Y
DriverAddress Text (30) N Y
DriverTown Text (15) N Y
DriverPostcode Text (8) N Y
ClubName FK Text(30) N Y Lookup from Club
Car CarlD PK Number Y Y
Make Text (15) N Y
Model Text (15) N N
Class Text (15) N Y Street Standard or
Street Modified or
Racing
Club ClubName PK Text (30) Y Y
SecretaryForename Text (30) N Y
SecretarySurname Text (30) N Y
SecretaryAddress Text (30) N Y
SecretaryTown Text (15) N Y
SecretaryPostcode Text (8) N Y
SecretaryTelephone Text (12) Y N
Event LicenceNo Number N Y
CarlD Number N Y
EventDate Date N Y
Timel Number N Y
Time2 Number N Y
Time3 Number N Y
Task Evidence Required
1 | Your teacher/lecturer will provide you with a partially | Completed data
completed data dictionary for the Event table. dictionary
Using the background information provided, complete the data | (Task 1 Proforma)
dictionary for the Event table by making appropriate entries in
the shaded areas as indicated.
You must now submit your answer to Task 1 to your teacher/lecturer.
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Before attempting the tasks in this section ask your teacher/lecturer for a completed data

dictionary.

You will also need access to pre-prepared database tables.

You MUST complete tasks in the sequence indicated.

Task

| Evidence Required

2 | Database tables have been created for the Driver, Car and Club tables.

(@) Using the completed data dictionary issued by your
teacher/lecturer, create the Event table. You should pay
particular attention to:

data type (text size)

required

validation — where appropriate ensure that only
valid values may be entered

primary and foreign keys

Hardcopy (printout or
screenshots) of table
structure including
field types, validation
checks etc.

(b) Set up/edit the relationships between all the tables as
indicated by the entity-relationship diagram.

Hardcopy (printout or
screenshots) of
relationships between
tables.

You must now submit all hardcopies for Task 2 to your teacher/lecturer.
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Ask your teacher/lecturer for the completed database. This database must be used to carry out
Tasks 3-5.

The events organiser at SRCA would like to know how many licensed drivers took part in each event.
To find this he has used his relational database management software to prepare the following report.

Number of Drivers at each Event

Date Mumber of Drivers

24/03/2012 23
22/04/2012 26
26/05,/2012 24
24/06/2012 26

The event organiser now wants a similar report but this time it should show the number of licensed
drivers in each club. The list should be ordered in alphabetical order of club.

Task

Evidence Required

3

Using appropriate database functions, create a report that
displays the total number of licensed drivers in each club. The
report data should be ordered by club name. Your report should
look similar to the one above, be labelled appropriately and
should include only the club name and number of drivers in
each club.

Printout of
report/layout
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The results committee of SRCA would like to send the secretary of each club a page of a report
showing the results for that club so far.

Dunshiel Motor Racing Club
Pre ston
24/05/2012 Timel Time2 Time3 TotalTime
Racing
Farris tche 59, 578 B4 5.4
Sreet Modifie:
Dane Thomso 6514 654 &M 186.32
oz Romri 19836
Steet Standard
Sioe B rtson 22408
Msicolm Ros 22498
Robbie Wilson 23127
22/04/201
Racing
Ha tche 153
Steet Modifie
Danie: Thomso
osh ROSTO
Sreet Standard
ae Robertsc
o e Wiisen
hicolm Ross
25/052012 i
Racing
Harris tche! 1R.23
Street Modifie:
Jozh Romr 218.20
Danie Thomso 21930
Sreet Standard
Gicoim Res 24108
Sie be rtso 24833
Robbie Wilso 24876
24/05/201 T
Racing
Ha tche 15
Sreet Modifie
Dane Thomso 185.96
Jozh Romr 188.44
Steet Standard
Maicolm Ros
Sk Robe rtso
Robbie Wilson
age 1ofS

The above example shows the results page for Dunshiel Motor Racing Club.

Task

Evidence Required

4

Create a report to show the above information for all the clubs
with each club fitted on a single separate page. Your report
should follow the above layout and format as closely as
possible, including the text “Secretary”, information about the
Secretary and a line after the information for each date. The
report should be sorted by date, class and total time as shown
above.

. Print evidence to show that there are 5 pages in total in
this report.
o Print the page to show the results for Dunton Drivers.

Printout of
report/layout

Printouts of

e Proof of 5
pages

e Correctclub
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The event organiser thinks it would be helpful to view a list of drivers at each Club. When a
specific club is chosen the Club Selector screen closes and is replaced by a list of all drivers
at that club. The list of drivers also includes a link back to the Club Selector screen, as
shown below using the “Dunton Drivers” club as an example.

Dunton Drivers

Club Selector Club Name corename  Surmame
Dunton Drivers E Aidan Clark
- .

Dunshiel Motor Racing club Dunton Drivers Dunton Drivers |Z| Gregor Watson
Dunton Drivers E Neil Murray
Dunton Drivers E Gail MacDonald

Scotia Motor Club SouthEast Scotland Car Club

Dunton Drivers [+]|andrew Stewart

Western Auto Association
Return to Club Selector

Fig (a) Club Selector Form Fig (b) Drivers at chosen Club

Task Evidence Required

5 | Your SRCA database already includes the Club Selector form
shown in Fig (a) above.

Choose one club and create, using a macro or script, a Printout of
navigational link to a separate form/layout that shows only the form/layout
drivers available from that club, as shown in Fig (b). Include
on this form/layout a link back to the Club Selector screen, Printout of macros/

again through the use of a macro or script. scripts used to control
navigational features
Each navigational link should close the current form/layout
and open the selected form/layout.
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Ask your teacher/lecturer for a copy the files required for this part of the task. They
should be in a folder/directory named SRCA Site.

The results committee want to create a website to show the results of the events as the year
progresses. The screenshot below shows the design of the homepage they would like.

h1 style

h3 style

body text style

Task Evidence Required

6 | Using web authoring software with which you are familiar
carry out the following tasks:

. Open the supplied file Home.html.

o Add the background image “background.jpg”.

. Define a style for hl with right aligned, italic, orange
text on a green background in a serif font.
o Define a style for body text which is centre aligned white

text in san-serif font.
. Apply the styles you have created to the appropriate text.
Format the text “Event Dates” as shown above.

Screen shot of
webpage

Printout of HTML

When you are finished, load your webpage into a browser of code

your choice. Obtain a screen shot of your webpage displayed in
the browser.

Using either your browser or web authoring software obtain a
printout of the HTML source code which displays your
webpage. Make sure your evidence includes all the code which
shows the structure and style definitions of your webpage.
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The results committee has now decided on the design of the pages to show the results for every event.
This is shown below.

Date of event

h1 ]
Left Aligned
Vertleally
aligned with
centre of Logo

Logo size:
Ly XX/XXIXX | width: 100
H@L@Mt:ég
Right aligned
Class Winner Time

Racing

Street

Street Modified

Navigation Links

X

Table of vesults
F0% width of screen
Narvow borders

T

Avea for navigation links as required

Task Evidence Required
7 | Using web authoring software with which you are familiar
create a template or master page for the results pages.
Your page should S hot of
o Follow the design ideas above c;eensl (t)t 0
o Have a similar layout and formatting as above emplate
o Have editable areas for all changeable text and links. Printout of HTML
Print code
o A screenshot of your template
o The HTML code for your template or master page.
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Task

Evidence Required

Use the template/master page to create four webpages —
one for each event date. You only need to fill in the correct
date for each page, the table can be left blank.

(b)

Create the following navigational structure for your
website.

° On the homepage each date should act as a
hyperlink to the appropriate results page.

° Each results page should have back, forward and
return to homepage links as appropriate.

Print the HTML code of your homepage and all of the
results pages

Printouts of HTML
of five pages

(@)

(b)

EITHER

The results committee would like to see your work so far.
Load each of your webpages into a browser and obtain a
screenshot of each page. Using appropriate software
assemble these images with appropriate captions into a
well-presented, well-structured single page document.
Include a short paragraph commenting on your progress so
far.

Print out your document.

OR

The results committee are worried about the size of the
website. Obtain one or more screenshots showing:

. The storage location of the folder/directory
containing the website files.

° The contents of this folder/directory along with the
size of each file.

Include these screenshots with appropriate captions in a
well-presented, well-structured single page document.

Include a short paragraph commenting on the file sizes.

Print out your document.

Printouts of single
page document
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Section 3

Marking Grid
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Marking Grid

Name Date
Task | Possible Actual Evidence Comment
Marks Marks
1 5 Completed data
dictionary
2(a) 5 Printout of table
structure
2(b) 2 Printout showing
relationships
3 3 Printout of report
4 11 Printout of
report/proof of 5
pages
5 4 Printout of
macros/scripts
6 10 HTML code and
screenshot
7 9 HTML code and
screenshot
8(a) 2 Observation of
creation from
template.
Webplus Site
manager HTML code
8(b) 6 HTML code
9 3 Document
60
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Appendix 1

Task 1 Proforma

Name

Data dictionary for Certificate entity

Data

Attribute Keys Type/Size Unique | Reqd | Validation
LicenceNo Number N Y
CarlD Number N Y
EventDate Date N Y
Timel Number N Y
Time2 Number N Y
Time3 Number N Y
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Appendix 2
Completed Data Dictionary

Only to be issued after completion and submission of Task 1

Entity Attribute Keys Data Unique | Required | Validation
Type/Size
Driver LicenceNo PK Number Y Y
DriverForename Text (30) N Y
DriverSurname Text (30) N Y
DriverAddress Text (30) N Y
DriverTown Text (15) N Y
DriverPostcode Text (8) N Y
ClubName FK Text (30) N Y Lookup from Club
Car CarlD PK Number Y Y
Make Text (15) N Y
Model Text (15) N N
Class Text (15) N Y Street Standard or Street
Modified or Racing
Club ClubName PK Text (30) Y Y
SecretaryForename Text (30) N Y
SecretarySurname Text (30) N Y
SecretaryAddress Text (30) N Y
SecretaryTown Text (15) N Y
SecretaryPostcode Text (8) N Y
SecretaryTelephone Text (12) Y N
Event LicenceNo PK/FK Number N Y Lookup from Driver
CarlD FK Number N Y Lookup from Car
EventDate PK Date N Y
Timel Number N Y >=40 and <=99.99
Time2 Number N Y >=40 and <=99.99
Time3 Number N Y >=40 and <=99.99
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Appendix 3

Detailed Marking Instructions

Strictly Confidential
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Detailed Marking Instructions — Do not issue to candidates.

Marks
1 Keys (1 mark each) 3,2,1,0
- Lookup from Driver/Lookup from CarlD 1
Data Dictionary 5 (all correct)
Validation Timel 1
2 Data type/size correct 1
PK correct 1
Create Event 5 Required correct 1
Validation correct — Lookups — 1mark 2,10
Time — 1 mark
3 correct one-to-many relationships = 2 marks 2,10
Links between tables 5 2 correct one-to-many relat_lonshlps =1 mark
0 or 1 correct or with help = 0 marks
(all with referential integrity)
3 Report showing total Calculate count for eagh club (query) 1
. . Sort club name ascending order 1
number of drivers in 3 - -
Layout (change total field name, field names ad 1
each club .
data visible).
4 Grouped by Club 1
Grouped by Date 1
Grouped by Class 1
R  for Dunt Total time calculated 1
D?i?/%rrs or bunton Sort by Total Time 1
' 11 Format time fields as fixed 2 decimal places 1
Report, Query and .
desi . Correct field order 1
esign required . . . « ”
Secretary details added (including text “Secretary”) 1
Line added after each date 1
Fit each club to a single page 1
Proof of 1 club on each of 5 pages 1
5 Navigation link from selector to list of Drivers
) 2,10
Navigation links 4 (clos_e, f_||ter, open_) -
Navigation from list of Drivers to Club Selector 210
(close, open) i
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Marks

6 Background image 1
Define style for hl 4,3,2,1,0
Text colour orange = 1 mark
Background colour green = 1 mark
Align right = 1 mark
Italic style = 1 mark
(above applied to text but not defined as style = 1
Home page mark)
(Mark from 10 | Define style for body 2,10
HTML code) Text colour/alignment = 1 mark
San-serif font = 1 mark
above applied to text but not defined as style =1
mark)
Text “Event Dates” formatted 2,10
Size H3/text colour white/centre aligned
(all 3 =2 marks, 2 correct = 1 mark)
Print HTML code 1
7 Template created 1
Editable areas created 1
Date vertically aligned to centre of logo 1
Result page Logo correct size 1
Masterftemplate | g I 5ate and | t horizontal alignment 1
(Mark from ate and logo correct horizontal alignme
HTML code) Table 3x4 L
Border size 1 or 2 1
Table 70% 1
Print HTML and Screenshot 1
8(a) | Results pages Create 4 results pages 2,10
(Evidence may 5 4 correct = 2 marks,
be package 3 or 2 correct = 1 mark
dependent)
8(b) Homepage hyperlinks 1
Page 2 forward and home links only 1
Navigation Pages 3 and 4 forward/back and home links 1
(Mark from 6 | Page 5 back and home links only 1
HTML code) HTML links correct 2,10

All correct = 2 marks, 1 or 2 errors = 1 mark,
>2 errors = 0 marks

Scottish Qualifications Authority
2011 Coursework Task

Higher Information Systems

2012/2013

26




9 e 5 webpages included on single 32,10
page
e Use of rows/columns Any three
Pages document e Correct order of images bu!let
e Distributed over page points 1
e Labels or captions mark each
e Explanatory text well formatted
and positioned
OR
9 e Correct images included Any three 3,2,1,0
e Rows/columns bullet
e Correct order points 1
Folder/Directory e Distributed over page mark each
Document e Labels or captions
e Explanatory text well formatted
and positioned
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Task 3

Number of Drivers per Club

Club Name

Dunshiel Motor Racing Club
Dunton Drivers

Scotia Motor Club
SouthEast Scotland Car Club
Western Auto Association

No of Drivers

Task 4 Possible evidence of multiple pages

v ol o1

Dunton Drivers
Secretary
Sharon Coyle
Biggarton Farm
MNorthbank
NO11 3RR
Timel Time2 Time 3 Total Time
24/03/2012 Racing Neil Murray 56.49 57.77 60.61 174.87
Andrew Stewart 56.99 59.70 60.77 177.46
Street Modified  Gregor Watson 65.84 66.67 6741 199.92
Street Standard ~ Gail MacDonald 72,01 7228 7242 21671
Aidan Clark 79.39 7592 7422 229.53
Timel Time2 Time3 Total Time
22/04/2012 Racing Neil Murray 53.65 53.18 55.76 162.59
Andrew Stewart 54.24 55.27 54.06 163.57
Street Modified  Gregor Watson 65.31 66.33 64.11  195.75
Page: 4 4 2 b { Mo Filter | | 4 [ [T | »
Street Modified  Gregor Watson 73.56 74.65 7189 221.10
Street Standard  Aidan Clark 82.83 83.38 7912 245.33
Gail MacDonald 81.71 B85.03 B3.31 250.05
Time1l Time2 Time3 Total Time
24/06/2012  Racing Andrew Stewart 459.02 49.2% 4327 147.58
Neil Murray 49,90 50.63 50.01 150.54
Street Modified  Gregor Watson 60.52 6041 6093 181.86
Street Standard  Aidan Clark 7404 7593 73586 223.53
Gail MacDonald 73.89 7e6.61 7502 225.52
Page 2 of 5
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Sample HTML for WebPlus

Task 6 Home page formatting

H1 formatting
-Heading-1-C

{
font-family:"Times New Roman', serif; font-style:italic; color:#ff8000;
background:#008000; font-size:32.0px; line-height:1.19em;

}

H3 formatting

-Heading-3-C

{font-family:"Times New Roman", serif; font-weight:700; color:#Fffffff;
font-size:16.0px; line-height:1.25em;}

-Heading-3-P

{margin:12.0px 0.0px 0.0px 0.0px; text-align:center; font-weight:400;}

} Body formatting

-Body-C-CO

{font-family:"Verdana', sans-serif; color:#ffffff; font-size:16.0px; line-
height:1.13em;

}

Click here to open style sheet to
show alignment for H1 and body

<link rel="stylesheet" href="wpscripts/wpstyles.css" type="text/css">

-Wp-Body-P
{margin:0.0px 0.0px 12.0px 0.0px; text-align:center; font-weight:400;}

-Wp-Heading-1-P
{margin:32.0px 0.0px 4.0px 0.0px; text-align:right; font-weight:400;

Background image

<body text="#000000" style="background-color:#ffffff;background-

image :url (background. jpg) ; background-repeat:no-repeat;background-
position:0Opx Opx;background-attachment:fixed; text-align:center;

height:766px;">

Text formatting

<hl class="Wp-Heading-1-P" style="margin-top:0px''><span class=""Heading-1-
C"">Scottish Racing Car Association</span></hl>

<hl class="Wp-Heading-1-P"><span class="Heading-1-C">Season 2012 results so
far</span></h1>

<h3 class=""Heading-3-P''><span class=""Heading-3-C''>Event Dates</span></h3>

<p class="Wp-Body-P''><span class=""Body-C-C0"'>24/3/2012</span></p>
<p class="Wp-Body-P''><span class=""Body-C-C0"'>22/4/2012</span></p>
<p class="Wp-Body-P''><span class=""Body-C-C0"'>25/5/2012</span></p>
<p class=""Wp-Body-P''><span class=""Body-C-C0"'>24/6/2012 </span></p>
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Task 7
New page with Master applied

Date and logo

<div style="background-color:transparent;text-align:left;margin-
left:auto;margin-right:auto;position:relative;width:750px;height:1000px;"">

J— This shows the width of the page

<td style="vertical-align:middle; padding:1px 4px 1px 4px;'>
<hl class=""Heading-1-P" style="margin-top:0px''><span class=""Heading-1-
C'">Date</span></h1>

</td><td style="'vertical-align:top; padding:1px 4px 1px 4px;'>

<p class="Table-Body-P""><span class="Table-Body-C"><img src="logo.gif"
width="100" height="68" border="0" title="" alt=""
style=""display:inline;float:right;margin:6px 6px 6px 6px;'></span></p>

<table id="table 2" cellspacing="0" cellpadding="0" style=" border-
collapse: collapse; position:absolute; left:112px; top:209px; width:526px;
height:174px;'> A

This number should be 70% of the
above page width

Table of results
<td style="vertical-align:top; padding:1px 4px 1px 4px; border:1px solid
#000000; ">

<p class="Wp-Table-Body-P"><span class="Table-Body-C-C0">Class</span></p>
</td><td style="'vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000;"">

<p class="Wp-Table-Body-P"><span class="Table-Body-C-CO">Winner</span></p>
</td><td style="vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000; ">

<p class="Wp-Table-Body-P"><span class="Table-Body-C-CO">Time</span></p>
</td></tr>

<tr style="height:40px;"'>

<td style="vertical-align:middle; padding:1lpx 4px 1lpx 4px; border:1px solid
#000000; ">

<p class=""Table-Body-P-P0"><span class="Table-Body-C-C0O">Racing</span></p>
</td><td style="'vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000;"">

<p class="Wp-Table-Body-P"><span class="Table-Body-C'">&nbsp;</span></p>
</td><td style="'vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000; ">

<p class=""Wp-Table-Body-P"><span class="Table-Body-C">&nbsp;</span></p>
</td></tr>

<tr style="height:40px;">

<td style="vertical-align:middle; padding:1px 4px 1px 4px; border:1px solid
#000000; ">

<p class=""Table-Body-P-P0"><span class="Table-Body-C-C0O">Street</span></p>
</td><td style="vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000;">

<p class="Wp-Table-Body-P"><span class="Table-Body-C">&nbsp;</span></p>
</td><td style="'vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000;">

<p class="Wp-Table-Body-P"><span class="Table-Body-C">&nbsp;</span></p>
</td></tr>
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<tr style="height:40px;">

<td style="vertical-align:middle; padding:1px 4px 1px 4px; border:1px solid
#000000; ">

<p class=""Table-Body-P-P0"><span class="Table-Body-C-CO">Street

Modi fied</span></p>

</td><td style="'vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000;">

<p class="Wp-Table-Body-P"><span class="Table-Body-C">&nbsp;</span></p>
</td><td style="'vertical-align:top; padding:1px 4px 1px 4px; border:1px
solid #000000;"">

<p class=""Wp-Table-Body-P"><span class="Table-Body-C">&nbsp;</span></p>
</td></tr>

Task 8a)

Proof of use of Master Page

Screen shot of Site Manager
£)) Site Manager » . l

[=J-Page Properties Page Properties SetPa
i i Name

‘Redirect Orage [ navigation

i Dﬁ index. html . Indude in Navigation .
- Background -

. Scind O L.T_’] page2.himl O tndude in Navigation
-Search O LT_’] page3.html O tndude in Mavigation
; - Security O |.T_°| page4.html Indude in Mavigation
[=-Master Page Properties O LL'] =iy A W Include in MNavigation
H -Background
i -Transition
i Hyperlink

Master Pages Height (pix})
756
1000
1000
1000

1000

ite setting {(none)
Contents, Master A
Use Site setting Contents, Master A 750
Use Site setting Contents, Master A 750
Site setting Contents, Master A 750

Homepage showing navigation links

<p class=""Wp-Body-P''><span class=""Body-C-C0""><a href="page2.html"
target="_blank" style=""text-decoration:underline;"'>24/3/2012</a></span></p>

<p class="Wp-Body-P''><span class=""Body-C-C0""><a href="page3.html™
style=""text-decoration:underline;'>22/4/2012</a></span></p>

<p class=""Wp-Body-P''><span class=""Body-C-C0""><a href="page4.html"
style=""text-decoration:underline;'>25/5/2012</a></span></p>

<p class="Wp-Body-P''><span class=""Body-C-C0""><a href="page5.html"
style=""text-decoration:underline;">24/6/2012 </a></span></p>
</div>
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Page 2 (March results) showing navigation links

<a href="index.html" 1d="btn_2" class="Buttonl"
style="position:absolute;left:311px;top:433px;width:139px;height:35px;"><sp
an>Home</span></a>

<a href="page3.html" id="btn_3" class="Buttonl"

style=""position:absolute; left:476px;top:434px;width:139px;height:35px;"><sp
an>Next</span></a>

Page 3 (April results) showing navigation links

<a href="paged.html" i1d="btn_4" class="Buttonl"

style="position:absolute; left:483px;top:449px;width:127px;height:32px; ' ><sp
an>Next</span></a>

<a href="index.html" id="btn_2" class=""Button2"

style=""position:absolute; left:310px;top:446px;width:139px;height:35px;"><sp
an>Home</span></a>

<a href="page2.html" id="btn_5" class="Button3"

style="position:absolute; left:141px;top:448px;width:133px;height:33px; ' '><sp
an>Previous</span></a>

Page 4 (May results) showing navigation links

<a href="index.html" id="btn_2" class="Buttonl”
style=""position:absolute; left:307px;top:457px;width:139px;height:35px;"><sp
an>Home</span></a>

<a href="page5.html" id="btn_4" class="Button2"
style=""position:absolute; left:498px;top:460px;width:127px;height:32px;"><sp
an>Next</span></a>

<a href="page3.html" i1d="btn_5" class="Button3"
style="position:absolute;left:132px;top:459px;width:133px;height:33px;"><sp
an>Previous</span></a>

Page 5 (June results) showing navigation links

<a href="index.html" 1d="btn_2" class="Buttonl"

style=""position:absolute; left:304px;top:443px;width:139px;height:35px; "' ><sp
an>Home</span></a>

<a href="paged.html" i1d="btn_5" class=""Button2"
style=""position:absolute; left:138px;top:444px;width:133px;height:33px;"><sp
an>Previous</span></a>

Scottish Qualifications Authority 32
2011 Coursework Task

Higher Information Systems 2012/2013



Sample HTML from Kompozer

Task 6 Home page formatting

<htmI>
<head>
<title>Home</title>
<style type="text/css">
hl {
font-family: "Times New Roman", Times,serif;
color: #ff9900;
background-color: #009900;
font-style: italic;
text-align: right;
}
body {
text-align: center;
color: white;
font-family: Arial,Helvetica,sans-serif;
}
</style>
</head>
<body style="background-image: url(Images/background.jpg);">
<h1>Scottish Racing Car Association</h1>
<h1>Season 2012 results so far</h1>
<br>
<br>
<h3 style="font-family: Times New Roman, Times,serif;">Event
Dates</h3>
24/3/2012<br>
22/4/2012<br>
25/5/2012<br>
24/6/2012<br>
</body>
</html>
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Task 7 Template HTML
<html template="true">
<head>
<meta content="text/html; charset=1SO-8859-1" http-equiv="content-type">
<title>Results Template</title>
</head>
<body>
<table
style="width: 100%; text-align: left; margin-left: auto; margin-right: auto;" border="0"
cellpadding="2" cellspacing="2">
<tbody>
<tr> <td>
<hl1><span editable="true" id="Date">XX/XX/XX</span></h1>
</td>
<td style="text-align: right;"><img style="width: 100px; height: 68px;" alt="logo"
src="Images/logo.gif"> </td>
</tr>
</tbody>
</table>
<br>
<table
style="width: 70%; text-align: left; margin-left: auto; margin-right: auto;"
border="1" cellpadding="2" cellspacing="2">
<tbody>
<tr>
<td style="text-align: center;">Class</td>
<td style="text-align: center;">Winner</td>
<td style="text-align: center;">Time</td>
</tr>
<tr>
<td>Racing</td>
<td><span editable="true" id="RacingWinner">RacingWinner</span></td>
<td><span editable="true" id="RacingTime">RacingTime</span></td>
</tr>
<tr>
<td>Street</td>
<td><span editable="true" id="StreetWinner">StreetWinner</span></td>
<td><span editable="true" id="StreetTime">StreetTime</span></td>
</tr>
<tr>
<td>Street Modified</td>
<td><span editable="true" id="StModifiedWinner">StModifiedWinner</span></td>
<td><span editable="true" id="StModifiedTime">StModifiedTime</span></td>
</tr>
</tbody>
</table>
<br>
<span editable="true" id="LinkArea">LinkArea</span><br>
<br>
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Task 8b
Homepage with links

<title>Home</title>
<style type="text/css">
hl {
font-family: "Times New Roman", Times,serif;
color: #ff9900;
background-color: #009900;
font-style: italic;
text-align: right;
}
body {
text-align: center;
color: white;
font-family: Arial,Helvetica,sans-serif;
}
</style>
</head>
<body style="background-image: url(Images/background.jpg);">
<h1>Scottish Racing Car Association</h1>
<h1>Season 2012 results so far</h1>
<br>
<br>
<h3 style="font-family: Times New Roman, Times,serif;">Event
Dates</h3>
<a href="Page%202.html" target="_top">24/3/2012</a><br>
<a href="Page%203.html" target="_top">22/4/2012</a><br>
<a href="Page%204.html" target="_top">25/5/2012</a><br>
<a href="Page%205.html" target="_top">24/6/2012</a><br>
</body>
</html>
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Page 2 with links

<IDOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"
"http://www.w3.org/TR/html4/loose.dtd">
<html templateref="/Results%252520Template.mzt">
<head>
<title>March results</title>
</head>
<body>
<table
style="width: 100%; text-align: left; margin-left: auto; margin-right: auto;"
border="0" cellpadding="2" cellspacing="2">
<tbody>
<tr>
<td>
<h1>24/3/2012</h1>
</td>
<td style="text-align: right;"><img style="width: 100px; height: 68px;" alt="logo"
src="Images/logo.gif"> </td>
</tr>
</tbody>
</table>
<br>
<br>
<br>
<table

HTML as for Template

</tbody>

</table>

<br>

<div style="text-align: center;"><a href="Home.html|"target="_top">Home</a></div></div>
<br>

<div style="text-align: center;"><a
href="Page%203.html"target="_top">Next</a><br></div>

</body>

</html>
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Page 3 links
<title>April results</title>

<tr>
<td>
<h1>22/4/2012</h1>
</td>

<div style="text-align: center;"><a href="Page%202.html|" target="_top">Previous</a><br>
<a href="Home.html|" target="_top">Home</a><br>
<a href="Page%204.html" target="_top">Next</a></div>

</body>
</html>

Page 4 links
<title>May results</title>

<tr>
<td>
<h1>25/5/2012</h1>
</td>

<div style="text-align: center;"><a href="Page%203.html|" target="_top">Previous</a><br>
<a href="Home.html" target="_top">Home</a><br>

<a href="Page%205.html" target="_top">Next</a></div>

</body>

</html>

Page 5 links

<title>June results</title>
</head>

<h1>24/6/2012</h1>

<a href="Page%204.html" target="_top">Previous</a><br>
<a href="Home.html" target="_top">Home</a><br>
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Sample HTML for Dreamweaver

Task 6 Homepage

DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01//EN"

"http://www.w3.org/TR/html4/strict.dtd">
<htmI><head>

<meta content="text/html; charset=is0-8859-1" http-equiv="Content-Type">

<title>Home</title><style type="text/css">
<I--
hl {
font-family: "Times New Roman", Times, serif;
font-style: italic;
color: #FF9933;
background-color: #009900;
text-align: right;
}
body {
font-family: Verdana, Arial, Helvetica, sans-serif;
color: #FFFFFF;
text-align: center;
background-image: url(Images/background.jpg);
}
stylel {font-family: "Times New Roman", Times, serif}
-->
</style>
</head><body>
<h1>Scottish Racing Car Association</h1>
<h1>Season 2012 results so far</h1>
<br>
<br>
<br>
<h3> <span class="style1">Event Dates</span></h3>
24/3/2012<br>
22/4/2012<br>
25/5/2012<br>
24/6/2012<br>
</body>
</htmi>
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Task 7 Template HTML
<body>
<table width="100%" border="0">
<tr>
<div align="left"><!-- TemplateBeginEditable name="Date" --><h1>Date</h1><!--
TemplateEndEditable --></div>
< div align="right"><img src=" Images/logo.gif" width="100" height="68" alt="logo"
[><[div>
</tr>
</table>
<p>&nbsp;</p>
<p>&nbsp;</p>
<div align="center">
<table width="70%" border="1">
<tr>
<th scope="col">Class</th>
<th scope="col">Winner</th>
<th scope="col">Time</th>
</tr>
<tr>
<td>Racing</td>
<td><!-- TemplateBeginEditable name="RacingWinner" -->RacingWinner<!--
TemplateEndEditable --></td>
<td><!-- TemplateBeginEditable name="RacingTime" -->RacingTime<!--
TemplateEndEditable --> </td>
</tr>
<tr>
<td>Street</td>
<td><!-- TemplateBeginEditable name="StreetWinner" -->StreetWinner<!--
TemplateEndEditable --></td>
<td><!-- TemplateBeginEditable name="StreetTime" -->StreetTime<!--
TemplateEndEditable --></td>
</tr>
<tr>
<td>Street Modified </td>
<td><!-- TemplateBeginEditable name="StModifiedWinner" -->StModifiedWinner<!--
TemplateEndEditable --></td>
<td><!-- TemplateBeginEditable name="StModifiedTime" -->StModifiedTime<!--
TemplateEndEditable --></td>
</tr>
</table>
</div>
<p>&nbsp;</p>
<p>&nbsp;</p>
<I-- TemplateBeginEditable name="LinkArea" -->Link Area<!-- TemplateEndEditable --
></div>
</body>
</html>
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Task 8

Homepage links

<html><head>

<title>Home</title><style type="text/css">
<l--

hi{

body {

stylel {font-family: "Times New Roman", Times, serif}
>
</style>
</head><body>
<h1>Scottish Racing Car Association</h1>
<h1>Season 2012 results so far</h1>
<br>
<br>
<br>
<h3> <span class="style1">Event Dates</span></h3>
<a href="Page 2.html">24/3/2012</a><br>
<a href="Page 3.html">22/4/2012</a><br>
<a href="Page 4.html">25/5/2012</a><br>
<a href="Page 5.html">24/6/2012</a><br>
</body></html|>

Page 2 links

InstanceBegin template="/Templates/Results Template.dwt"
codeOutsideHTMLIsLocked="false" -->

<head>

<meta http-equiv="Content-Type" content="text/html; charset=is0-8859-1" />
<I-- InstanceBeginEditable name="doctitle" -->

<title>March results</title>

div align="left"><I-- InstanceBeginEditable name="Date" --><h1>24/3/2012</h1>

<I-- InstanceBeginEditable name="Links" -->
<p><a href="Home.html">Home</a></p>
<p><a href="Page 3.html">Next</a></p>
<I-- InstanceEndEditable --></div>

</body>

<I-- InstanceEnd --></htm|>
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Page 3 links

<I-- InstanceBeginEditable name="doctitle" -->
<title>April Results</title>
<I-- InstanceEndEditable -->
<I-- InstanceBeginEditable name="head" -->
<I-- InstanceEndEditable -->
</head>
<body>
<table width="100%" border="0">
<tr>
<th scope="col"><div align="left"><!-- InstanceBeginEditable name="Date" -->
<h1>22/4/2012</h1>
<I-- InstanceEndEditable --></div></th>

<p>&nbsp;</p>
<I-- InstanceBeginEditable name=" Link Area " -->
<p><a href="Page 2.html">Previous</a></p>
<p><a href="Home.htm|">Home</a></p>
<p><a href="Page 4.html">Next</a></p>
<I-- InstanceEndEditable --></div>

</body>

<I-- InstanceEnd --></htm|>

Page 4 links
<I-- InstanceBeginEditable name="doctitle" -->

<title>May results</title>
<!-- InstanceEndEditable -->

<body>
<table width="100%" border="0">
<tr>
<th scope="col"><div align="left"><!-- InstanceBeginEditable name="Date" -->
<h1>25/5/2012</h1>
<I-- InstanceEndEditable --></div></th>

<p>&nbsp;</p>
<I-- InstanceBeginEditable name="Link Area " -->
<p><a href="Page 3.html">Previous</a></p>
<p><a href="Home.html">Home</a></p>
<p><a href="Page 5.html">Next</a></p>
<!-- InstanceEndEditable --></div>

</body>

<!-- InstanceEnd --></html|>
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Page 5 links
<I-- InstanceBeginEditable name="doctitle" -->

<title>June results</title>
<!-- InstanceEndEditable -->

<th scope="col"><div align="left"><!-- InstanceBeginEditable name="Date" -->
<h1>24/6/2012</h1>
<I-- InstanceEndEditable --></div></th>

<I-- InstanceBeginEditable name="Body" -->
<p><a href="Page 4.html">Previous</a></p>
<p><a href="Home.html">Home</a></p>
<I-- InstanceEndEditable --></div>

</body>

<I-- InstanceEnd --></htm|>
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